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Downloading Vs. Streaming –  

What’s the Difference? 

By Phil Sorrentino, Contributing Writer, 

The Computer Club, FL 

http://scccomputerclub.org 

Philsorr.wordpress.com philsorr(at)yahoo.com 

 

Downloading is something most of us do, almost 

without thinking about it. Streaming is 

something we rarely do, unless we watch a lot of 

movies from YouTube or another such video 

streaming service. Downloading refers to 

receiving data from a remote computer. The data 

comes “down” to you from another system. The 

received data is typically a data file of some 

specific type, like a picture or a video, which is 

then stored on the local computer, for use in the 

near or distant future. The received file is called 

a download. The downloading process will 

progress as fast as the server computer can send 

the data to your computer. 

That process will be affected by (1) your 

computer’s capability, (2) the communications 

equipment between the server and your 

computer, and (3) how busy the server computer 

is at that specific time. The download really 

comes in many pieces, and the network protocol 

software in your machine reconnects all the 

pieces so the received file is identical to the 

original. 

Downloading is done for many reasons. New 

software is typically acquired by downloading. 

(I’m sure you already have Google Earth or 

Picasa on your computer. Both were acquired by 

a download.) Email attachments are obtained by 

downloading. (Isn’t it being nice to have those 

pictures of grandchildren and pets?) Documents 

are transferred by downloading. (Remember the 

User’s Manual you downloaded when you 

bought your camera?) 

Just as a little aside, here. Downloading and 

Streaming are both supported by network 

software included as part of the Operating 

System. There are many network protocols used 

on the internet, two of which are HTTP 

(Hypertext Transfer Protocol) and FTP (File 

Transfer Protocol). HTTP is the predominant 

protocol used on the internet and really defines 

the World Wide Web. Most of our computing 

activities are on the WWW, so it is HTTP that 

allows our computers (clients) to connect to web 

server computers in order to accomplish things 

like checking our email, making hotel 

reservations, purchasing something on line, 

downloading a picture or video file, or streaming 

a movie. FTP is used mostly to transfer computer 

files from one computer to another, and most of 

us will rarely, if ever, use it. 

Now we know that downloading is the 

acquisition of a file, from a remote server 

computer, for future use. You may be thinking; 

if downloading is receiving a file, is there a way 

to send a file? Well, you guessed it, as you might 

have thought, it is called uploading. Until 

recently, the only uploading most of us may have 

done was to attach a document or picture to an 

email.         (continued on Page 3) 
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January 20th Meeting - Fairfax 
Viruses in the Era of Genomics 

Presented by Paolo Amedeo, PhD 

 

This talk will concentrate on human-pathogenic 

viruses, starting with a brief overview of viral 

diversity both in terms of genomic organization, 

structure and “life cycle.” "I will discuss the 

technical challenges of sequencing viral nucleic 

acids, especially from unknown viruses." 

 

“Finally, I will talk about various types of 

bioinformatic analysis to study viral spread and 

evolution, and will present several examples in 

which synthetic biology could be of tremendous 

help in the rapid creation of safe vaccine strains." 

"I graduated in 1995 from the university of Pavia 

(Italy) with a master in molecular biology. In 2000 I 

received my PhD in botany/plant molecular biology 

from the University of Basel working on 

transcriptional gene silencing at the Friedich 

Miescher Institute (FMI - Novartis). Soon after, I 

moved to San Diego for a postdoc at the Torrey 

Mesa Research Institute (TMRI – Syngenta) 

working on fungal molecular biology and 

genomics." 

"At TMRI I transitioned from prevalently wet lab 

work to full-time bioinformatics. In 2003 I joined 

The Institute for Genomic Research (TIGR – now 

part of JCVI) in Rockville as bioinformatics 

analyst, working on the structural and functional 

annotation of the genome of Cryptococcus 

neoformans (a human pathogenic fungus causing 

serious respiratory diseases and fungal meningitis). 

I worked in the Eukaryotic Bioinformatics Core 

Facilities till 2009, when I moved to the Viral 

Bioinformatics Team, which I currently lead." 

 

Learn in 30: Geocaching 
Presented by John Krout 

Geocaching is an outdoor hobby: People hide 

containers called geocaches in parking lots, parks 

and some surprising locations, and publish a 

description and map coordinates, latitude and 

longitude, of each geocache on geocaching.com. 

Some geocaches are large enough to include toys 

and other treasures that will fascinate your kids or 

grandkids and maybe you too. You will see 

examples of geocache containers, see maps and 

web pages describing geocaches near where you 

live, and learn about geocaching apps so you can 

find caches using location services based on GPS 

on your phone or tablet. There are more than 100 

caches in Arlington County and several hundred in 

Fairfax County. 

 

John Krout has an MS in computer science and has 

worked in the computer business as a trainer, 

software engineer and documentation writer for 30 

years. He bought a hiking GPS for finding 

geocaches in 2003. He has found caches in all of 

the Virginia State Parks, 82 of the 95 counties in 

Virginia, and in 38 US states. His total count of 

caches found is 2,200+ and continues to grow on 

most weekends. While hiking to find caches, he has 

lost weight, reduced his heart rate and blood 

pressure, and shot many eye-catching photos. 
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(Continued from Page One) 

The act of “attaching” was actually uploading a file 

(the attachment) to the email server, so it could be 

sent with the body of your email. But now with 

Cloud Servers like OneDrive, Google Drive, and 

Dropbox, the way you get your files to the cloud is 

by uploading them. Uploading your pictures and 

videos, or any file that you want to share with 

others, is probably the first thing you will do after 

you have set up an account with one of these Cloud 

services. (By the way, if you haven’t tried a Cloud 

Service yet, give one a try. OneDrive and 

GoogleDrive will give you at least 15GB of storage 

space, free.  

OneDrive is hosted by Microsoft, and you guessed 

it, GoogleDrive is hosted by Google.) 

Downloading is receiving a file from a remote 

server for future use. (In fact, the file cannot be 

used until the complete file is received and stored.) 

Streaming is similar, in that it is the transfer of a 

file from a remote server to your local computer. 

But the difference is that the file pieces, as they are 

received, are immediately used and typically are not 

stored for future use. 

As you can imagine, the software to handle 

streaming is different in that it must process the 

pieces of the file, in real-time as they are received, 

and do it fast enough so no pieces of the file are 

lost. So, streaming is the process of receiving 

sequential pieces of a file and using those pieces 

immediately as they are received while the 

transmission continues its progress to the end of the 

file. Streaming data is provided by video and audio 

file streaming services. YouTube is an example of 

such a video streaming service, as is Netflix and 

Vimeo. (By the way, you can upload your favorite 

videos to YouTube and Vimeo for sharing.) 

Streaming is used to view, in real-time, a video file, 

like a movie, or listen to music in real-time from a 

music source. In video streaming, each of the file 

pieces is a frame of the video and the frames are 

sequentially displayed on the computer monitor, 

thereby providing motion to the picture on the  

monitor. Video frames may have to be displayed at 

rate of 60 frames per second, so the streaming 

software has to get all of its work done within 1/60th 

of a second so it can be ready for the next frame. If 

the hardware and software cannot process the 

frames fast enough, frames may be dropped, and 

the resultant picture will stutter or jump. Audio 

streams are slower than video streams, but they too 

have to produce the audio sound from each file 

piece before the next piece arrives. (Pandora is an 

example of an audio streaming service.) 

Now you can see the difference. Downloading is 

receiving a complete data file and storing it for 

future use, while Streaming is receiving a file and 

processing the contents, piece by piece, sequentially 

from the beginning to the end of the file 

transmission. Now to experience them, first hand, 

try both a download and a streaming video or audio. 

Try downloading Synctoy from Microsoft, a utility 

that will help you handle your data backup 

(http://www.microsoft.com/en-

us/download/details.aspx?id=15155), and Stream 

something from YouTube to help you with setting 

up your data backup:  

https://www.youtube.com/watch?v=GiNZPzFxoSc 

 

What to Expect in Microsoft Office 2016 

By Nancy DeMarte, 1st Vice President, Sarasota 

Technology User Group, FL 

Sarasota Technology Monitor 

www.thestug.org  

ndemarte (at) Verizon.net 

Amid all the hype about Windows 10, another 

Microsoft product has been released: Office 2016. 

As we all know, Microsoft Office has been the 

preferred office suite in the business world for 

many years. Many companies still find that for 

productivity, a PC, keyboard and mouse are the best 

option for workers, although tablets are gaining 

popularity. Office products are not going away.  On 

July 9 2015, the Mac version of Office 2016 was 

released to the public. Prices for various versions 

are predicted to be much the same as Office 2013. 

The subscription Home Premium version, Office 

365, will cost about $100 a year for five 

http://www.microsoft.com/en-us/download/details.aspx?id=15155
http://www.microsoft.com/en-us/download/details.aspx?id=15155
https://www.youtube.com/watch?v=GiNZPzFxoSc
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installations and $70 a year for the personal, one 

installation edition. The standalone edition will 

have a one-time price of 

$140.  

It appears that Office 2016 is 

being built around a few key 

goals. It is designed as a 

cross-platform application 

that will work well on a 

computer, tablet or 

smartphone. It also emphasizes online collaboration 

and has added some new tools to aid in this goal. In 

some apps, several people will be able to view and 

edit the same project simultaneously. Users will be 

able to see not only who is currently viewing their 

project, but also who is editing it. All apps in the 

suite will offer more efficient methods of saving, 

opening, and editing files in OneDrive. Office 2016 

will also include a few new features and several that 

have been improved. It appears that anyone who 

has used Office 2007 or later can transition easily to 

Office 2016. There are no jarringly new tools 

requiring a long learning curve. It is touted as being 

a perfect complement to Windows 10, but will work 

smoothly on Windows 7 or 8. 

A few new features are worth a mention. One is the 

Tell Me bar, which is an updated approach to Help. 

A user can ask how to perform a task by typing in 

the bar or verbally asking Cortana, the talking 

personal assistant, and will be taken to the 

appropriate spot in the Microsoft support site. 

Another is Clutter, a feature of the Outlook email 

program that sorts emails and assigns low priority 

ones to a special folder for later consideration. 

Another improvement in Outlook is the option of 

choosing how much email to download at once onto 

a phone or small device. Currently, it’s a month’s 

worth, which can slow down download time. The 

Insights feature now extends to Excel and 

PowerPoint instead of just Word and Outlook. If 

you right click a word or phrase, a sidebar appears 

containing information related to it from Bing 

search, Wikipedia, and the Oxford dictionary.  

 

It appears that individual applications in the suite 

have not changed their basic operation too much, 

probably to help businesses avoid excessive re-

training. But there are predicted to be a few 

changes. Excel has new analysis capabilities and 

one click forecasting based on the data on the 

spreadsheet. It also has some new chart types, such 

as Waterfall and Tree Map, and keyboard access to 

Pivot Tables. Outlook lets the user attach links to 

files in OneDrive. Word and PowerPoint 

automatically insert photos with the correct 

orientation and offer more shape styles. One 

complaint from the bloggers is that PowerPoint, 

Publisher, and Word have the same sets of 

templates as they did in Office 2013. There are, 

however, more themes available. Plus, as I write 

this, more revisions can still be made. 

The new Office will have some formatting changes. 

Each application will sport a different color, as 

indicated by its icon and title bar. For instance, 

Word is blue; Excel is green. The suite color 

scheme, which has been white, will become 

somewhat darker to allow easier accessibility for 

sight-impaired users.  

So, should you plan to get Office 2016? If you are 

thinking of using Office on a tablet or phone, using 

either the Windows, Apple, or Android operating 

systems, Office 2016 can give you a more touch-

friendly experience than previous versions. If a 

laptop or desktop is still what you prefer to use for 

productivity jobs, as I do, you might not need to 

make the change to Office 2016. You may decide to 

wait for the next Office edition, which, if Microsoft 

follows its pattern, will be 2019. But if you are still 

hanging on to Office 2003 or earlier, it is time to 

upgrade, if for no other reason than much better 

security. If you do decide to update your Office 

suite, keep in mind that you can get more features 

and much better cloud storage if you purchase the 

subscription (365) version than if you buy the 

standalone version 
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Acronis True Image 2017 for PC or MAC 

By Bart Koslow, Reviews Editor, Channel Islands 

PCUG, CA 

www.cipcug.org 

bartkoslow (at) verizon.net 

I have used Acronis True Image for many years and 

have found it to be the best backup program 

available. In the last few years it has changed from 

a desktop backup program to an internet of things, 

multiple devices and cloud backup program. There 

are two license versions, a one-time purchase 

perpetual license and an annual subscription version 

which adds full cloud backup and one year phone 

support. I will be reviewing the one-time purchase 

version. 

Acronis True Image (ATI) is not your father’s 

backup program, which only backed up your PC to 

an external hard drive, DVD, CD or flash drive. It 

has expanded to become an all devices, and 

Facebook backup program. ATI omits the cloud 

backup, but may be expanded to use the cloud for 

an additional fee. Acronis claims that the 2017 

version is 60% faster than last year and 3 times 

faster than any competitor. I have compared ATI to 

all the major backup programs in the past and at 

that time verified that it was the fastest. ATI 2017 

backs up my new computer (which has an Intel i7-

6700 CPU, a 500 GB Solid State Drive and a SATA 

600 MBs 1 GB spinning drive) in 10 minutes. 

Using ATI 2016 on my last computer took an hour 

and 20 minutes. The SSD backup takes only 4 

minutes. 

There are over 50 new features in ATI 2017. Major 

new features include: Backup any IOS or Android 

mobile device (not Windows mobile devices) to 

your PC or MAC using WIFI. Note that your 

computer must have a WIFI connection on the same 

network as your mobile device to enable mobile 

backup to a PC. My new desktop computer does not 

have WIFI, but my laptop does. One nice feature is 

that you may migrate between IOS and Android in 

the event you change your platform or use both 

types of devices. ATI 2017 has the ability to 

remotely backup to any computer anywhere in the 

world, providing each has ATI 2017 installed. You 

may now manage all your computers from one 

place. ATI permits you to backup Facebook data in 

the background to your PC, and browse and search 

Facebook content in the backup. I would not be 

surprised if future ATI versions offer similar 

backups of other social media sites’ data. 

Backup and 

Restore remains 

the same. You have 

all the selections 

for image backup 

and restore choices 

for your computer 

that previously 

existed, like non-stop background backup, full, 

incremental, etc. There are numerous options to 

customize your backups like scheduling the time, 

the type of backup, notifications, any exclusions 

from the backup and a host of advanced choices 

including backup validation. You also have 

multiple choices of where to backup, whether hard 

drive (internal or external), solid state drive, USB 

flash drive, file server -NAS or NDAS, network 

share, FTP server, DVD or Blu-Ray, or memory 

card. You may use password protection with 256-

bit AES encryption for your backups to prevent 

prying eyes from viewing your confidential data. 

ATI has Mobile Device Data Backup apps for 

Android and Apple devices. I could not find a 

Mobile Device Backup app for Windows when 

searching the Windows store. Using the online 

Dashboard (loaded from the ATI menu), you may 

access and manage (delete, restore, backup, remote 

access, etc.) Archives, Syncs, and Backups from 

any of your devices, and backup data from any 

device that is on.  

Advanced features and tools include: Try & Decide: 

When you turn Try & Decide on, your computer is 

in the Try mode. After that, you can perform any 

potentially dangerous operations without worrying 

that you might damage your operating system, 

programs or data. When you turn Try & Decide off, 

you decide if you want to apply the changes to your 

computer or you want to discard them. Startup 

Recovery Manager: The Acronis Startup Recovery 
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Manager lets you start Acronis True Image 2017 

without loading the operating system. With this 

feature, you can use Acronis True Image 2017 by 

itself to recover damaged partitions, even if the 

operating system won't boot. Unlike booting from 

Acronis removable media, you will not need a 

separate media or network connection to start 

Acronis True Image 2017. Acronis Secure Zone is a 

special secure partition that you can create on your 

computer for storing backups. Acronis Secure Zone 

uses a FAT32 file system. You can Clone your disk 

image to a new disk; Create Rescue Media on a CD, 

DVD, or flash drive to use if your computer is not 

bootable; Create Universal Restore Media to restore 

an image to dissimilar hardware, which includes 

migrating your system from a hard disk drive to a 

solid-state drive; Backup to NAS (network attached 

storage); Archive less used files to an external 

device, and more.  

Tools, the fourth menu item, contains utilities that 

allow you to clone your disk image to a new disk, 

create rescue media on a CD or flash drive to use if 

your computer is not bootable, create universal 

restore media to restore an image to dissimilar 

hardware, which includes migrating your system 

from a hard disk drive to a solid-state drive.  

ATI comes with a free copy of Parallels Access. 

This is a program that allows you to remotely 

access and control your computer from a tablet or 

cell phone. There are apps for Android, IOS and 

Amazon. It sells on the internet for $40. 

Acronis support is excellent and comprehensive. I 

had reason to use online support. Using their 

TeamViewer, a support person took control of my 

computer and fixed my problems. 

The new Acronis True Image 2017 is a large, 

versatile program. With all its expanded 

capabilities, it continues to lead the field. It is 

relatively easy to use. There is a manual you may 

download as well as a comprehensive Help file. I 

recommend the Acronis True Image 2017 for 

everyone from novices to experts. It is still the best 

you can find.  

A one computer version is available for User Group 

Members from Gene Barlow, User Group Relations 

at: http://www.ugr7.com/products.html for $25. 

You may also purchase the 1 year subscription 

version at equally low prices.  

Requirements 

Windows XP SP3, Windows 7 SP1 (all editions), 

Windows 8 (all editions), Windows 8.1 (all 

editions), Windows Home Server 2011, Windows 

10 

Apple OS X Mavericks 10.9.5+, OS X Yosemite 

10.10.2+, OS X El Capitan 10.11, iOS: 8.x and later 

Android: 4.4.x and later 

Support: Acronis provides multiple free support 

methods for ATI as follows at www.acronis.com:•

 1 year free email and chat support•

 Knowledge Base 

Video Tutorials 

• User Forum 

Support: If you purchase from User Group 

Relations, ontact Gene Barlow at gene@ugr7.org 

for help and answers to your questions. 

 

My Digital Photography for Seniors 

Book Review By Charles Flum, Director, 

Boca Raton Computer Society 

Boca Bits cflum1@comcast.net 

My Digital Photography for Seniors  

Jason R. Rich 

Que Publishing ©2016  

ISBN 780789755605 

 

Introduction 

There are many seniors who are technologically 

challenged as they did not grow up with all the 

mailto:cflum1@comcast.net
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gadgets available to us today. Computers, phones, 

tablets, digital cameras, all have a learning curve. 

This book is an introduction to the wonderful world 

of digital photography, aimed at seniors, but 

applicable to anyone just starting out. 

Review 

Rich's main emphasis is on using the camera in 

your phone or tablet. He barely touches on stand-

alone digital cameras. The assumption seems to be, 

if you are just starting out, you are not going to buy 

an expensive camera, rather you will use the one 

already in your pocket or in your carrying bag.  

He reinforces this opinion in the title of his first 

chapter, “Getting Started with Digital Photography 

Using Your Mobile Device”. 

The next two chapters give a basic overview of how 

to take photos under varying conditions using your 

mobile device.  

He gives specific step-by-step instruction for both 

the iPhone and Android devices throughout the 

book. With one exception, this reviewer feels he is 

clear in his instructions and on target.  

On p. 85 Rich states, “Taking a candid shot of one 

or more people is relatively easy, as long as you 

(the photographer) are positioned in the right place 

at the right time and you don't interfere in any way 

with the person or people you're photographing.” In 

the reviewer’s experience, it is very difficult to take 

a candid photo that captures the exact moment 

wanted. It takes patience and a bit of luck (right 

time and right place) to capture a great candid. 

How to transfer photos from your phone or tablet to 

your computer, editing your photos on your mobile 

device or computer and how to organize your 

photos on these devices are covered in the next six 

chapters.  

Numerous ways to 

share your photos, via 

email, online, a 

digital diary, printing 

from a service or your 

own printer, and 

creating a photo book 

round out the next six 

chapters. 

The book is lavishly 

illustrated, each written step in a process is 

numbered and shown on the illustration what button 

you need to push or swipe in your device to 

accomplish the task.  

The detail is fabulous for a newbie. Others, who are 

more experienced, can scan the steps to reinforce 

their knowledge. 

Conclusion: There are hundreds of books explaining 

photography, none which this reviewer has seen 

which is as complete as Rich's book is for the 

newbie.  

It is a very easy read. It can be read cover to cover, 

or you can read the specific chapters which interest 

you. A welcome addition to books for the beginner 
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My Chrome Away from Home 

[& Air Traveler's Lament - -Ed.] 

By Greg Skalka, President,  

Under the Computer Hood User Group, CA 

Drive Light; president (at) uchug.org 

I’m writing this on my new Chromebook at 30,000 

feet over the Pacific. I decided to take my 

Chromebook with me on a vacation trip, as I 

wanted to see how useful it would be as a traveling 

companion. I also wanted to continue exploring the 

capabilities of this device. I’ve had it for a couple of 

months, but have not had the opportunity to 

investigate all its features. 

For a very low-cost device (I paid only $130 for my 

Acer Chromebook 11 at Fry’s on a promo code 

deal), it so far has proved to have a lot going for it. 

At home, I would often use it daily to look up 

something on the internet, as it can boot up very 

quickly. Even though I planned to take my normal 

Windows laptop on this trip, I really wanted to take 

this Chromebook. I was not confident enough in it 

to leave my familiar Windows PC friend behind, 

however. With space and weight an issue on an 

airline trip, I probably didn’t need the hassle of 

taking two screens and chargers. My quest for 

knowledge won out, however, and I determined I 

could take them both. My wife likes the 

Chromebook as well, and did not discourage me in 

taking it. She insisted on bringing her laptop as it 

has work software on it, so between the two of us, 

we are traveling with two laptops, an iPhone and a 

Chromebook. 

It is interesting that I am so enthusiastic about this 

Chromebook. I am much more excited to use it than 

I am my iPad Mini. Maybe I’ve never gotten into 

the Apple way of thinking, but I find the Chrome 

OS much easier to understand and operate. Maybe 

it is because the OS is symbiotic with the Chrome 

browser, which I have been using for a while on 

Windows computers. Chrome also seems a lot more 

like Windows in its approach to things, while I 

think Apple goes out of its way to be different. 

The travel environment is also quite different these 

days, in some good ways and some not so good. 

This is my first flight since the FAA and airlines 

loosened up restrictions on electronic devices on 

commercial flights. Previously, almost all passenger 

electronics had to remain off from taxi to 10,000 

feet, and from descent down to landing. My main 

gripe with those restrictions was that, with the 

advent of digital photography, I could no longer 

take photos out of the plane window during take-

offs and landings, and at low altitudes when the 

views are the most interesting. I took lots of those 

kinds of photos in the old 35 mm film days (with an 

older manual camera), so it was really refreshing to 

be able to take some great shots over San Diego at 

dawn when we took off. 

 

The airlines are much more integrated into the 

digital world since my last flight. In addition to 

checking in online and printing my boarding passes 

for Alaska Airlines, I was able to pay my bag fees 

(more on that later) and print luggage tags, speeding 

up check in. Even the aircraft are more 

accommodating for travelers with electronic 

devices. Alaska now has USB and 110 VAC power 

outlets at every seat, so you can arrive at your 

destination with your devices fully charged. They 

also have the now-standard paid Wi-Fi and movies, 

though not over the ocean. 

In spite of these advances in technology and some 

very friendly and helpful employees, the airlines 

have found ways to turn air travel from an exciting 

adventure into an expensive battle of attrition. I’m 

traveling to paradise, Hawai’i, through a metal tube 
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crammed full of people and luggage. Airlines once 

were known for service, with everything, including 

meals, drinks and baggage service included. In the 

last ten years or so, however, it seems to me that the 

airlines have moved profits to their number one 

priority, and moved customer service way down on 

the list. Planes are now typically always full, 

overhead bins are overflowing, any refreshments 

other than soda and peanuts are costly and bags 

usually have to pay to fly as well. The seats look 

thinner, less padded (lighter to save fuel) and are 

probably closer together now. 

This flight that my wife and I were on was 

completely full, so while I was in the window seat 

taking photos, my wife was in the middle seat on 

one side of a center aisle, with a large man in the 

aisle seat adjacent to her flowing over the arm rest. 

Even on an almost six-hour flight, we received no 

complementary meal service, just drinks and 

pretzels (there was someone on our flight with 

peanut allergies, so no peanuts were served). The 

airline did provide several choices in meals they 

offered for sale, or we could also bring our own 

food on the plane to consume (a trend that does not 

work so well for those other passengers with food 

allergies, as there is no way to limit what foods 

customers bring on). My wife and I chose to bring 

on some snacks, and eat some equally expensive 

airport terminal food before boarding. 

We also had to pay additional fees for the airline to 

transport our checked bags (two bags in total, at 

$25 each). With a lot of airlines now charging bag 

fees, a lot of customers try to avoid them by 

bringing more in their carry-on luggage. This 

results in less space in overhead bins and more time 

spent boarding passengers, as they search for space 

in an overhead bin. Getting off the plane takes 

longer with more passengers trying to exit down the 

aisle with rolling carry-ons. I did see fewer 

passengers with laptops on our flight; most 

passengers played with their smart phones and 

tablets instead. Of course, maybe they didn’t bring 

them out on the plane, preferring, like me, to use 

their smaller electronic devices in the cramped 

seating. 

So far, the Chromebook has done well on the trip. 

With over 8 hours of battery capacity, I’m not 

worried about trying to fish my charger out of my 

bag to try the airline’s in-seat power. It boots up 

and shuts down in around ten seconds, so I can 

check things quickly. It was able to easily connect 

to the free airport Wi-Fi and the GoGo inflight Wi-

Fi hub on the plane. Even though the Chromebook 

was built to be online, I can easily write this column 

in Google Docs while offline, and save the file on 

my USB thumb drive (or so I thought; more on this 

later). I can play music I brought on the thumb 

drive (I found that ear buds, though compact for 

travel, give poor results with all the background 

noise on a plane), or watch a movie file I brought. 

So, why bring the larger and heavier 14” Windows 

laptop?  While I can get all my email through a web 

browser, it is so much easier with Thunderbird, 

which is not available under Chrome. I can also feel 

safer checking my email on free airport Wi-Fi, as I 

have a VPN on my laptop (the setup of my Private 

Internet Access VPN under Chrome OS appears 

difficult). I also have a 1 TB hard drive in the 

laptop, so as I fill up camera memory cards with 

vacation selfies, I can off-load to the laptop drive 

and then snap more pics. With only the 

Chromebook, I’d have to either invest in more 

memory cards, or resurrect the old photo hard 

drives I thought were obsolete (and are now quite 

small). 

Once we arrived at our destination, we still used the 

Chromebook a lot to look up local points of interest 

and map out sightseeing trips. I found, however, 

that the Chromebook was no match for the old 

familiar laptop in some respects. Perhaps with 

further experience on the Chromebook, I may find 

out how to do all the things I found a lot easier (or 

possible) with the laptop. 

One thing I have not quite figured out is Google 

Docs. I think I understand the Chrome Files app; it 

is similar to Windows File Explorer (I’ve yet to 

figure out how to do the same things on my iPad). I 

started writing this column in Google Docs on the 

airplane, which, since I was not able to connect to 

the internet, was in off-line mode. I tried to save 
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and get out of Docs a few times early on, to make 

sure it was actually saving the file. I was unable to 

determine where it was being saved on the 

Chromebook, however. I finally tried to save the 

column on my USB thumb drive, and thought I had, 

but was not able to open the .gdoc file with my 

Windows laptop. I might have been able to install 

the Google Drive program on my laptop, or there 

might be a way to export the file from the 

Chromebook as a .docx file. In the end, I took the 

easy way out and selected all of the column’s text 

in Google Docs on the Chromebook, and then 

pasted it into an email (in Gmail). I sent the text in 

an email to an account I use with Thunderbird on 

the Windows laptop, and then pasted the text into 

Word, where I could edit and write comfortably. 

I guess I still have a few things to learn about 

Chromebooks. I’m glad I brought it on this trip, as 

it has a lot of advantages over my Windows laptop. 

I probably overestimated how much time I’d have 

on this vacation trip to learn about and experiment 

with the Chromebook. I brought some eBooks on 

the Chromebook to read, but that’s not really what 

my wife had in mind for our vacation. 

 

 

Polaroid Cube – A Review 
George Harding, Treasurer, Tucson Computer 

Society, AZ 

TCS eJournal www.aztcs.org 

georgehardingsbd (at) earthlink.net 

The name pretty much describes what you see for 

this product. It’s a photo cube with things on four of 

the six sides. 

On top is the multifunction button. It controls 

On/Off and, when On, whether you are taking a still 

or a movie. The front has the camera and a small 

aperture for the microphone. The company says the 

lens captures 124° of field, although my tests show 

somewhat less. Still, that’s a pretty wide angle. The 

bottom has an embedded magnet for stable 

attachment to any metal object. This is an easy, but 

not very useful, way to step away from the camera 

for motion pictures or stills. 

On the back inside a compartment sealed with a 

slotted disk are: a slot for a microSD card of up to 

32 GB; a switch to shift from720mp to 1080mp; a 

micro USB slot for the included cable used to attach 

your laptop or computer. 

 

The laptop or computer connection allows charging 

the Cube while displaying the stills and movies 

contained on the microSD card. You can access the 

data through your laptop, but there is also an app 

available that allows a few other controls. 

Light Frequency switches from 60 Hz to 50 Hz to 

eliminate flickering that may be present when 

taking movies in artificial light. 

Timestamp whether or not to be included in stills 

and movies and to be displayed when viewing 

same. 

Cycle Recording records over existing movie files 

to save storage. 

Date & Time to set the date and time to whatever 

you want. 

Sync with Computer so the time and date are 

whatever your laptop or computer has at the time 

the still or movie is taken. 
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Camera Buzzer Volume Multifunction button 

presses generate one or more beeps; this control 

makes them more or less audible. 

The User Guide includes basic information, but is 

rather short on details. 

The device is pretty simple when you understand 

how to do it. There are a number of accessories 

available for use with the Cube. The tripod mount 

may be one of the most useful. Pointing the camera 

at the target you want is not easy and the mount 

would make it much easier. 

It would be helpful if there were a way to access the 

camera’s function with an app for your smartphone 

Since Cube is not Wi-Fi capable, the app would not 

work for it. Their successor product the Cube+ is 

Wi-Fi equipped and available at a higher price. 

 

About: Polaroid Cube 

Vendor: Polaroid 

www.polaroid.com Price: $99 

 

 

Enliven Documents with Themes 
By Nancy DeMarte, 1st Vice President, 

Sarasota Technology User Group, FL 

Sarasota Technology Monitor 

www.thestug.org  

ndemarte (at) Verizon.net 

If you often find yourself creating documents in 

Word or spreadsheets in Excel, you probably use 

the same font and layouts most of the time. You 

would be surprised how lively and stylish these 

files could be if you applied a theme to them. 

Themes in Word and Excel are Style sets that 

coordinate the color scheme, fonts, line and 

paragraph spacing, and effects. The Themes gallery 

is located on the Design tab in Word and the Page 

Layout tab in Excel. I will use Word 2013 as an 

example of how you can apply and customize 

themes in your documents.  

 

 

Choose and Apply a Theme 

 

The default theme in Word and other Office 

programs is appropriately named “Office,” but you 

can apply a different theme to a document either 

during its creation or after. For example, I opened a 

blank document, clicked the Design tab, then 

Themes (left side of the ribbon), to open the 

Themes gallery. I chose the “Ion” theme, although I 

could have browsed for more online. A group of 

Styles that coordinate with this theme appeared in 

the ribbon. I chose a colorful one called “Lines 

(Simple)” and began to create my document.  

First, I typed the title and highlighted it to display 

the Font toolbox just below it. I clicked Styles 

(bottom right) and selected the Title style, which 

changed my title to a maroon color and 40-point 

text. The title seemed too large, so I reduced the 

font size to 24 points. All these font changes can 

also be made on the Home tab – Font group. 

Next, I typed an introduction and my first heading, 

highlighted it, chose Styles from the font toolbox 

again, and picked Heading 1. It also was a maroon 

color, 18 points, and included a line below it. I 

changed the size to 14 points to be consistent with 

the new title size. 

http://www.polaroid.com/
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Then I typed the body of the document. After I had 

typed the first line of text, I clicked inside a word 

and learned that the theme’s body text was Century 

Gothic, 10.5 point, Normal style.  

Just for fun, I added a couple of shapes from the 

Shapes gallery (Insert tab – Shapes) Sure enough; 

they too were a maroon color, keeping with the 

theme.  

Customize and Save a Theme 

 

Next, it was time to experiment with changing a 

few of the elements of the theme. With my 

document open, I clicked the Design tab and then 

Colors, which revealed a menu of color schemes, 

each which included several coordinated colors. I 

clicked “Blue” and immediately found that all my 

maroon-colored features had turned a medium blue. 

Then I clicked Fonts and chose “Times New 

Roman – Arial.” The title and all the headings 

became the Times New Roman font, while the body 

text changed to Arial. 

  

With my cursor still in the document, I clicked 

Paragraph Spacing, which displayed a list of preset 

distances between lines and paragraphs. Hovering 

my mouse over Default showed my theme’s 

spacing. I hovered my mouse over each of the 

choices to preview how it would affect my 

document. I decided on the Open spacing set, which 

added a little more space between lines and 

paragraphs. Because I had only a few objects or 

shapes in this document, I did not change the 

Effects, but clicking that icon showed me what 

changes were possible.  

Now it was time to save this custom theme. I 

clicked the Design tab, Themes button, and selected 

“Save Current Theme” at the bottom of the gallery. 

I typed a name, “My Ion,” in the dialog box and 

clicked Save. This put my modified theme into the 

Custom area above the Theme gallery. The theme 

was also stored as MyIon.thmx in a special 

Document Themes folder.  

Two Important Cautions 

1. Don’t confuse saving a theme with setting it 

as the default. If you save your custom 

themes, you have the choice of when to use 

them. If you set a custom theme as the 

default, it will affect all future documents 

and may give you some unexpected results. 
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2. The Office theme is different from the rest 

in the theme gallery in that it affects all of 

the Office applications. If you make a 

change to the Office theme, such as 

changing the background from white to 

gray, and set it as the default, it will affect 

all programs in your Microsoft account, 

including those on other computers. 

However, saving your own custom themes 

in Word or Excel can be a handy way to 

give your documents some style and avoid 

re-creating a favorite theme each time you 

need it. 

 

Taking Photos with Your iPad (and iPhone) 

By Jim Cerny, Columnist, Sarasota TUG, FL 

Sarasota Technology Monitor 

www.thestug.org / jimcerny123 (at) gmail.com 

Your iPad tablet device (and your iPhone) are 

excellent devices for taking photos and videos. We 

will discuss taking and working with photos in this 

article, but taking videos is similar. All iPads and 

iPhones have a “Camera” app to TAKE photos, and 

a “Photos” app to VIEW your photos. 

THE CAMERA APP -- Tap 

this app to begin using the iPad 

built-in camera. Immediately 

you will see an image of what 

your iPad camera is seeing 

through its lens. Move your 

iPad to see on the screen what 

you want to take a photo of, wait a moment for the 

image to focus (you will see a small yellow-

outlined rectangle on the image as it adjusts the 

focus). You may tap on the image anywhere to 

move this focusing rectangle to another place if you 

wish, then tap the large white button. You will hear 

a “click” and your photo is now saved on the 

“camera roll” on your iPad. (Before taking your 

photo, you can “zoom in” by touching the screen 

with two fingers and spread them apart.) 

 

When you are using the camera, you can tap on the 

small white camera outline icon to switch between 

the front or rear lens of your device. The front lens 

(facing you) is best used during Skype or video 

calling. Some settings for your camera can be 

changed in the “Settings” app, such as turning a 

grid pattern on or off. The “HDR On” option (just 

touch to change to “HDR Off”) will allow your 

iPad to take three photos at almost the same time 

and provide one best photo using the three images. 

(I have noticed no significant difference whether 

HDR is on or off). In addition to the “photo” 

option, there is the “video” option (to take videos, 

obviously) and a “square” option for taking square 

(i.e. not rectangular) photos. Scroll to choose. Your 

most recent photo will be shown at the bottom 

corner of the screen and you can touch this photo to 

open the “Photos” app. 

THE PHOTOS APP -- 

Touch this app to open 

and view your photos. 

You can scroll through 

all your photos in your 

iPad memory and they 

are already sorted by 

date. To delete a photo, 

touch it to open the 

photo on the screen, then touch the little blue 

garbage can in the bottom corner of the screen. 

Touch on “Delete Photo” when it appears to 

confirm the delete. Your photos can be used in 

various ways, printed (if you have a printer that 

works with your iPad), sent to other places, etc. 

You can also organize your photos into ALBUMS. 

You can think of an “album” as a “folder”. You can 

create a new album by touching the “album” icon at 

the bottom of the screen which opens your list of 

albums, then touch the “+” to add a new album and 

give it a name. At this point you will see your 

collection of photos and you can “select” the ones 

you want to “copy” into that album. A photo you 

have “selected” will have a blue circle with a 

checkmark in it on the photo. You can copy the 

same photo into multiple albums if you want. If you 

DELETE a photo from an album you are only 

deleting the copy you put in that album. If you 

DELETE a photo from your “photos” (that is, you 
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are NOT in viewing albums) then that photo will be 

deleted from your device including all the albums 

you copied it into. 

FUN TIP:  To take a photo of whatever is on your 

iPad screen at any time, just hit the “home” and the 

“power” buttons at the same time. 

You can download any number of free and low-cost 

apps that will work with your photos and allow you 

to edit and enhance them. However, the Photos app 

that comes with your iPad can do some editing. 

Touch “Edit” at the top right of the screen when 

you have selected a photo to see your options – 

such as rotate, enhance, filters, red-eye removal, 

and crop. 

The camera of your iPhone will work the same 

way. The iPhone will have a flash built-in, whereas 

the iPad does not. 

MORE TIPS: 

It is a good idea to backup your photos somewhere 

else for safekeeping. You can do this when your 

iPad (iPhone) is connected to your computer or you 

could save your photos to some memory in the 

“cloud”. 

Take photos and experiment with them. Learn how 

to find them and organize them into albums. 

Learn more by using Google and YouTube – ask 

questions such as “How do I delete a photo from 

my iPad?” 

Review your photos on your device on a regular 

basis and DELETE the photos you no longer want. 

(If you can NOT delete a photo then the photo was 

most likely put on your device from someplace 

else.) 

Having your iPhone with you means that you have 

never forgotten your camera at home or in the car! 

 

 

Co-Editor(s) Wanted – Help PATACS NOW!! 

PATACS needs you to help produce this Posts 
newsletter in print and electronic editions.  

Templates are available to help in this noble 

endeavor.  There’s more to learning about 

computers and technology than 140 characters!  

Please - Contact:  director2 (at) patacs.org 

 

 
Special Membership Promotion - Members who 

bring a *new member to the organization will 

receive a 6 months' extension of their membership. 

The new member should list your name as the 

'source' of their membership on the application 

form. *New member - has not been a member in the 

36 months prior to month of received application. 

http://patacs.org/membershippat.html 

Donations to PATACS help us provide our 

newsletter, video webinars and recordings of our 

meetings.  We are an IRS-recognized non-profit, 

educational organization, classified as 501(c) (3). 

 

http://patacs.org/membershippat.html
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